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一、引言

1.1关于说明书

本说明书描述了网关 PD-100S的各项参数，具体使用方法和注意事项，方便工程人员的操作运用。在使

用网关之前，请仔细阅读本说明书。

1.2版权信息

本说明书中提及的数据和案例未经授权不可复制。泗博公司在产品的发展过程中，有可能在不通知用户

的情况下对产品改版升级。

是上海泗博自动化技术有限公司的注册商标。

该产品有许多应用，使用者必须确认所有的操作步骤和结果符合相应场合的安全性，包括法律方面，规

章，编码和标准。

1.3相关产品

本公司其它相关产品包括：

PD-100等。

获得以上产品的说明，请访问公司网站 www.sibotech.net，或者拨打技术支持热线：021-5102 8348

1.4 术语

DeviceNet ： DeviceNet 协 议 ， 符 合 GB/T18858.1,GB/T18858.3 及 DeviceNet Protocol Release 2.0

PROFIBUS-DP：PROFIBUS-DP协议

1.5更改记录

◆ 2013年 10月修订 V41：

[1] 去掉电源端口（三针端子）的描述。

http://www.sibotech.net
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二、产品概述

2.1产品功能

网关 PD-100S实现了 DeviceNet和 PROFIBUS-DP的数据通信。可连接具有 DeviceNet接口的主站设备到

PROFIBUS-DP 网络，实现带 PROFIBUS-DP接口的 PLC与 DeviceNet接口的 PLC之间的通信。

注：DeviceNet端口作为从站的固件(Firmware) 与 DeviceNet主站不同，订货号为 PD-100S。DeviceNet网络侧

如为主站，型号为 PD-100。

2.2 产品特点

▼应用广泛：实现 DeviceNet设备网与 PROFIBUS-DP总线网络之间的直接连接。如：实现 Rockwell、Omron

与西门子 S7系列多种 PLC之间的双向数据交换。

▼应用简单：用户不必了解 PROFIBUS和 DeviceNet技术细节，用户只需参考产品手册及提供的应用实例，

根据要求完成网络配置，即可在短时间内连接网络。

▼透明通信：用户可以依照 PROFIBUS通信数据区和 DeviceNet通信数据区的映射关系，实现 PROFIBUS

到 DeviceNet之间的数据透明通信。

2.3技术指标

[1] PROFIBUS DP V0从站功能，遵循 EN50170和 JB/T 10308.3-2001：测量和控制数字数据通信工业控制

系统用现场总线第 3部分：PROFIBUS规范；

[2] DeviceNet支持最多 224字节的输入和 224字节的输出，32、96、48、112、72、160、192、224字节

可选；

[3] 模块上提供了光电隔离 PROFIBUS-DP接口和 DeviceNet接口，2.5KV 隔离；

[4] DeviceNet端口为从站，支持 DeviceNet I/O Poll扫描；

[5] DeviceNet支持的波特率有 125K，250K，500K以及自动波特率侦听；

[6] 多个 LED状态灯指示，方便现场调试；

[7] 模块从 DeviceNet 网络取电，供电电压直流 DC 11~26V；

[8] 温度：-20℃~60℃ 相对湿度：0~95%(无凝露)

[9] 功耗： <4W

http://www.sibotech.net
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[10] 外形尺寸 40mm（宽）*125mm（高）*110mm（深）；

[11] 安装方式：35mm导轨安装；

[12] 防护等级：IP20。

http://www.sibotech.net
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三、产品外观

3.1 产品外观

3.2指示灯

DeviceNet模块状态指示灯(MS)

拨 码 开 关 ： 设 置

DeviceNet 地址及波
特率

旋码开关：设置
PROFIBUS-DP
地址

DeviceNet 接口

PROFIBUS-DP接口

LED数码管：显示网
络状态及地址

LED指示灯

RS232端口

http://www.sibotech.net
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指 示 灯 状 态 含 义

关闭 可能未供电或者指示灯坏

绿色常亮 工作正常

绿色闪烁 未能正确配置，或者处于波特率自动侦听状态

红色闪烁 可恢复的故障

红色常亮 不可恢复的故障

红－绿闪烁 正进行自检

DeviceNet网络状态指示灯(NS)
指 示 灯 状 态 含 义

关闭 DeviceNet电路未供电
绿色闪烁 设备已在线但没有已建立的连接

绿色常亮 设备已在线且已建立了连接

红色闪烁 一个或多个 I/O连接已经超时
红色常亮 设备检测到无法恢复的错误，且不能进行通信，例如

DeviceNet地址在网上有重复

RS232口指示灯（SE）
指 示 灯 状 态 含 义

TX 关闭 串口无数据发送

TX红灯闪烁 串口有数据发送

RX 关闭 串口无数据接收

RX绿灯闪烁 串口有数据接收

PROFIBUS-DP网络状态灯（PB）
指 示 灯 状 态 含 义

PBF 关闭 数据通信正常

PBF 红灯常亮 PROFIBUS-DP总线通信失败
STA 关闭 PROFIBUS-DP总线上无数据通信
STA绿灯闪烁 PROFIBUS-DP总线上有数据通信

3.3配置开关

PROFIBUS-DP地址旋码开关配置说明：

0
2

×10 ×1

A B

http://www.sibotech.net
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如上图所示其 PROFIBUS-DP地址计算公式为：

PROFIBUS-DP 地址=（A×10）+（B×1）

DeviceNet地址及波特率设置拨码开关说明：

3-8位开关为 DeviceNet地址设置开关，对应 DeviceNet地址的#1-#6位，其为由低到高的二进制编码（On

为 1，Off为 0）。

第 1、2位为 DeviceNet波特率设置开关，说明如下：

 
第2位 第1位

1 1

1 0

0 1

0 0

自动侦听

500K

250K

125K

波特率

3.4 LED数码管

LED数码管显示的主要内容包括：DeviceNet地址以及 PROFIBUS-DP地址。上电后，LED数码管依次显

示“pb”、当前 PROFIBUS-DP地址、“dn”、当前 DeviceNet地址。

OFF

ON 1 2 3 4 5 6 7 8

http://www.sibotech.net
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3.5 端口

3.5.1 DeviceNet 端口接线说明

DeviceNet侧采用开放五芯连接器：

V+GND CAN_L

SHIELD

CAN_H

1 5

 1号脚接 24V地

 2号脚接 CAN_L

 3号脚接屏蔽

 4号脚接 CAN_H

 5号脚接 +24V

注：PD-100S_V40及之后的版本，模块上无单独的电源端口，模块通过 DeviceNet端口供电。

3.5.2 PROFIBUS-DP 端口接线说明

PROFIBUS-DP接线说明如下图所示：

DB9 引脚 功能

1 NC（不连接）
2 NC
3 PROFI_B（必须连接），数据正
4 RTS
5 GND
6 PROFI_5V
7 NC
8 PROFI_A（必须连接），数据负
9 NC

http://www.sibotech.net
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3.5.3 RS-232 端口

配置端口，与计算机连接后，可通过超级终端修改 PD-100S的配置参数。具体见第六章节配置步骤。

http://www.sibotech.net
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四、工作原理

PD-100S的 DeviceNet和 PROFIBUS之间的数据转换通过“映射”关系来建立。在 PD-100S中有两块数据

缓冲区，一块是 PROFIBUS网络输入缓冲区，另一块是 PROFIBUS网络输出缓冲区。DeviceNet将读取的数

据写入到网络输入缓冲区，供 PROFIBUS网络读取。网关同时从网络输出缓冲区取数据，通过 POLL I/O写命

令输出到相应的 DeviceNet设备。

PD-100S既作为一个 DeviceNet节点，同时也作为一个 PROFIBUS-DP的节点，需要占用两边网络的节点

地址。

输入缓冲区 输出缓冲区

http://www.sibotech.net
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五、快速使用指南

以下几个步骤可以快速应用您的 PD-100S：

1）按照配置步骤配置网关。具体见第六章节。

2）通过网关侧面的旋码开关设置你所需的 PROFIBUS-DP地址，可参考 3.3章节。

3）通过网关下面拨码开关设置 DeviceNet地址及波特率，可参考 3.3章节。

4）按照接线说明正确接线。可参考 3.5章节。

5）把 EDS文件导入到 DeviceNet组态软件（如 RsNetWorx），配置 DeviceNet网络。此时用户可以配置

DeviceNet扫描命令和 DeviceNet到 PROFIBUS-DP的数据映射，具体见第七章节；

6）把 GSD文件导入到 PROFIBUS-DP组态软件（如 STEP 7），将 PD-100S的 PROFIBUS-DP输入输出映

射到 PLC或其它设备，具体见第八章节。

http://www.sibotech.net
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六、网关配置说明

用户通过网关的 RS232接口以及 232直连线（随 PD-100S一起发给客户，一端为三星端子、另一端为

DB9接头）可以将网关连接到 PC，通过超级终端配置网关。将网关上所有拨码开关拨到 OFF，并且将旋码开

关的值拨到 0，重新上电后网关即进入配置模式。

6.1 配置超级终端

打开Windows自带程序超级终端（开始—所有程序—附件—通讯—超级终端），连接时使用的端口为客

户当前使用的串口，端口设置如下：

6.2配置主菜单

配置完超级终端，给系统上电， PBF红灯常亮（其余灯全灭，数码管不显示），超级终端显示配置程序
的主菜单，如下图所示：

http://www.sibotech.net
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菜单（1）：设置 PROFIBUS-DP<->DeviceNet输入输出字节数长度，32、96、48、112、72、160、192、

224字节可选，默认为 48字节；

菜单（2）：打开或者关闭 DeviceNet网络状态字。当选择打开时，网络输入数据的最后两个字节为状态

字。可选择将断开网络侧输入的数据清零或者保持最近一次的更新；

菜单（3）：设置数据交换方式，不交换、两字节交换、四字节交换可选；

菜单（4）：设置工作方式，有两种工作方式可以选择：兼容模式（新版本同时支持之前的 PD-100SV3.1

版本模式）和正常模式（PD-100S V4.1版本模式）；

菜单（5）：显示当前设置：PROFIBUS-DP<->DeviceNet输入输出字节数、状态字是否使用、数据交换方

式及产品序列号、硬件版本、固件版本；

菜单（6）：更新固件。

http://www.sibotech.net
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6.2.1 当前配置显示

在配置主页面选择输入“5”，显示当前的所有配置，第一次进入超级终端配置页面，可通过选择该选项

查看配置，判断需要进行哪些设置修改：

6.2.2 输入输出字节数设置

在配置主菜单中输入“1”后，弹出输入输出字节数长度设置选项以及当前配置，如下图所示：

http://www.sibotech.net
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当需要改变设置时，通过输入代表字节数的不同序号设置输入输出字节数。下图选择为 48字节输入输出。

http://www.sibotech.net
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6.2.3 状态字设置

在主配置页面输入“2”，会弹出状态字设置选项以及当前配置：

http://www.sibotech.net
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当需要更改设置时，按照提示，输入“y”表示使用状态字，输入“n”表示不用状态字。

当输入“y”时，网络输入数据的最后两个字节是状态字。输入“y”后，弹出“是否清零”选项：

输入“1”：数据清零；

输入“2”：数据不清零，保持最近一次更新的数据。

注意：当选择不使用状态字时，断开网络侧的输入数据会被强制清零。

配置页面如下图所示：

http://www.sibotech.net
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6.2.4 数据交换方式设置

在主配置页面选择 3，弹出数据交换方式设置选项及当前配置：

输入“1”：不交换；

输入“2”：双字节交换；

输入“3”：四字节交换。

配置选项如下图所示：

http://www.sibotech.net
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6.2.5设置工作方式

在配置主页面输入“4”时，弹出设置工作方式设置选项及当前配置：

输入“1”：兼容模式（新版本同时支持之前的 V3.1版本模式，即支持使用 V3.1对应的 EDS文件和 GSD

文件进行数据通讯）；

输入“2”：正常模式（PD-100SV4.1版本模式）。

配置选项如下图所示：

http://www.sibotech.net
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当输入“2”，选择“正常模式”时，就出现如下界面：

http://www.sibotech.net
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6.2.6 更新固件

在配置主页面输入“6”时，界面会弹出“Press y to enter the mode to update the firmware. Press any other key

to exit”字样。

此时，输入“y”即可进入更新固件模式，输入其它值可退出更新固件选择。输入“y”后，界面弹出“Please

close the serial port and start the firmware upgrading program”，显示如下：

http://www.sibotech.net
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按照提示操作，断开超级终端连接，此时即可进行固件更新操作。

注意 1：断开超级终端后，在更新固件之前，不能通过键盘输入任何值，防止这些值通过串口影响产品

固件。

注意 2：超级终端中设置的 PROFIBUS-DP<->DeviceNet输入输出字节数及数据交换方式都可在总线网络

中进行配置，具体见第七、八章节。

注意 3：若要退出配置模式，只需要把拨码开关或者旋码开关设置为非 0值，给网关重新上电，网关即进

入正常运行状态。

http://www.sibotech.net
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七、DeviceNet网络配置说明
用户需要将光盘中的 PD100S.EDS注册到 DeviceNet组态软件，才能通过网络组态软件配置。

7.1 EDS注册

用户需要将光盘中的*.EDS文件注册到 DeviceNet组态软件，才能通过网络组态软件配置。

EDS（Electronic Data Sheet）电子数据表格是支持 DeviceNet 的设备的网络功能的全面描述。相当于

Windows上设备的驱动程序。用户需要把 EDS文件注册到 DeviceNet网络组态软件，如 RsNetWorx等，才可

以通过网络组态软件进行进一步的配置。

下面我们以常用的 Rockwell公司的 RsNetWorx为例（版本 4.12.0），说明如何注册，进一步的详细说明，

请参考您所用的网络组态软件的说明书。

Step 1：创建一个新的网络配置文件

Step 2：选择 EDS操作向导，在“Tool”菜单中，选择“EDS-Wizard”，您会看到：

http://www.sibotech.net
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Step 3：选择下一步：

Step 4：注册网关 PD-100S：

如上图所示，选择“Register an EDS file”，将显示下面界面：

http://www.sibotech.net
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请注册我们提供的 PD-100S.EDS文件，根据您存放 EDS文件的位置，选中该文件。

Step 5：确认注册所选择的文件；

按下一步：

http://www.sibotech.net
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Step 6：选择图标。

下面网络组态软件将提示您该设备在设备库中存放的类别，按缺省值确认，在这个过程中可以选择图标。

http://www.sibotech.net
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到这里，该设备已经成功地注册到了组态软件的设备库中的图示位置。

接下来，您将网关设备 PD-100S接到 DeviceNet网络上，按下 RsNetWorx的“浏览”按钮，或者在菜单中

选择“Network-Online”，您的网关设备将被系统扫描到并且正确的识别。

7.2 DEVICENET参数信息

您可以在 RsNetWorx中在线(Online) 组态设备，也可以离线组态完设备后，再进入在线模式，详细请参

考 RsNetWorx手册。

以下我们的组态演示是在离线“Offline”状态下。

网关 EDS 的
注册位置

http://www.sibotech.net
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从 左 侧设 备 库 中 ， “Vendor” （ 制 造商 号 ） “Shanghai Sibotech Automation Co. Ltd” 目 录 下将

“DeviceNet/PROFIBUS-DP Gateway”拖到编辑区，选择与实际设备地址相符的地址号，然后双击该设备，您会

看到以下画面，

您也可以在这个界面中修改设备地址“Address”。点击“Parameter”，进入参数界面，显示下图：

http://www.sibotech.net
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这是设备在 RsNetWorx网络组态软件中的 DeviceNet参数画面。

注意：如果通过该界面修改 I/O bytes参数，下载后需要将网关上电重启才能生效。

第一个参数是“PROFIBUS status”，表示当前 PROFIBUS-DP总线的状态；

第二个参数是“I/O bytes”，表示 DeviceNet输入输出字节数，在 32、96、48、112、72、160、192、224字

节中可选，默认为 48字节；重新设置并下载后需要重启网关。

用户可以根据实际需要的字节长度来选择网关所用的输入输出字节长度。修改了这个参数，用户需要注

意在配置 1756-DNB 模块 DeviceNet主站模块的扫描列表(Scan List)时，配置的输入输出和这里的设置相对

应。

第三个参数是“Swapping Data”，表示网关在两个网络中交换数据时，是否需要交换先后顺序，可选择“No

swapping”（不交换）、“Two bytes swapping”（双字节交换）和“Four bytes swapping”（四字节交换）。该参数

下载以后，立即生效，掉电也能保存。默认为双字节交换。

注意：如果映射的数据为多字节变量，PROFIBUS-DP的表示为高有效字节先传输，而 DeviceNet为低有

效字节先传输，因此需要字节交换。某些公司，如 GE的 PLC，有数据 Swap功能，用户可以将这个功能根据
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自己需要打开。

PD-100S也有数据交换功能，可以选择不交换字节先后顺序，双字节交换和四字节交换。

例如：选择了“Two bytes swapping”

DeviceNet侧输出：

1 2 ... 3 4

2 1 ... 4 3

PROFIBUS-DP侧得到的输入数据同上。

例如：选择了“Four bytes swapping”

DeviceNet侧输出：

1 2 3 4 5 6 7 8 ...

4 3 2 1 8 7 6 5 ...

PROFIBUS-DP侧得到的输入数据同上。

注意：DeviceNet 输入输出字节，在表示多字节变量的时候，LSB（最低有效位的字节）先传，这是由

DeviceNet协议规定的。PROFIBUS-DP的输入输出字节，在表示多字节变量的时候，MSB（最高有效位的字

节）先传。这样用户可能需要交换数据的高字节和低字节。

注意：当选择使用状态字时，网络输入数据的最后两个字节就是状态字，这时字节交换对最后两个字节

无效。

第四个参数是“Using Status Word”，是否使用状态字设置：“Yes”表示使用状态字，“No”表示不使用状

态字。默认为“NO”。

第五个参数是“Clear Data”，表示是否将断开网络侧的输入数据清零：“Clear Data”表示将断开网络侧的

输入数据清零，“Keep Last Data”表示保持断开侧网络的最近一次更新数据，并不清零。默认为“Clear Data”。
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7.3配置 PLC的 I/O扫描输入输出

这一节简要介绍，如何通过 RsNetWorx配置 RSLogix5000+1756/DNB的 I/O扫描参数表。

PLC平台：Rockwell的 ControlLogix5555

DeviceNet接口卡：1756DNB

组态软件 RsNetWorx

第一步：打开 1756DNB的属性页对话框，进入“Scan list”标签页。

第二步：在上述界面中，选择要加入扫描列表的设备，然后点击箭头按钮，然后可以看到：

点击
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设备进入了 1756-DNB DeviceNet主站的扫描列表。

如果客户很了解如何配置 DeviceNet，你可以点击“Edit I/O Parameters...” 自行修改，否则就根据缺省配置，

点击确认，把所有的设备都添加到扫描列表。

下图是点击“Edit I/O Parameters...”后出现的对话框，用户可以在这里设置 I/O数据输入输出的触发方式：

轮询、周期性发送、逢变则报等，还可以选择输入/输出字节。

注意：输入输出字节数是一个关键！PLC/DeviceNet主站建立连接时会核对这里配置的输入输出字节数和

设备实际应答的输入输出字节数，如果不一致将不能建立起 DeviceNet I/O连接，也就不能进行输入输出。
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第三步：确认输入输出映射。

用户可以查看 Input和 Output属性页，这里就是设备的 DeviceNet I/O信息如何与 1756DNB的内存数据关

联的设置。一般采用自动设置（AuotMap）即可。
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第四步：下载相应的扫描列表到 1756DNB。根据提示操作即可。

第五步：编制相应的程序，下载到 ControlLogix，然后将 PLC状态转换到运行，如果在编程状态，PLC

进行 DeviceNet I/O扫描，不会输出数据（IDLE），只会输入数据。

注意：1756DNB在开发 PLC程序时，需要将 1756DNB的一个运行控制位设置为 1。

如果模块在机架上的位置为 1号，即 Local:1:O.CommandRegister.Run这一位。

梯形图程序示例：

http://www.sibotech.net


www.sibotech.net 36

7.4 选择 Online 路径

从离线到在线状态，用户需要选择路径。

根据用户实际的配置选择路径，下图是用串口（DF1）的图示。
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如果用户有什么进一步的问题，建议参考 RsNetWorx的用户手册。
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八、PROFIBUS-DP网络配置说明
以下说明怎样使用 STEP7 去设置 PD-100S。

首先，把 *.gsd 文件复制到以下路径：Step7\S7data\gsd\

1. 打开 SIMATIC Manager ：

2. 在 File->New, 新建一个文件：
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3. Insert->Station->SIMATIC 300 Station：

打开 S7 PLC 硬件设置：SIMATIC 300(1)->Hardware, 双击：
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4. 在菜单中选择 Options->Install GSD file, 在 Device 目录中更新 GSD：

将 GSD文件放在相关目录下，选择并注册后，您可以在硬件组态界面找到您注册的设备，硬件组态界面

右侧窗口的 /PROFIBUS DP/Additional Field Devices/Converter/PD-100S，如下图所示：
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5. 设定 PLC rack, 双击“Hardware Catalog\SIMATIC 300\RACK-300\Rail”
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6. 设定 CPU 模块，选择对应的设备类型和所占用的槽位。

7. 创建 PROFIBUS-DP网络，设置 PROFIBUS-DP： New->Network settings，选择 DP，选择一个波特率如

187.5Kbps，然后 “OK”。双击它：
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8. 选择 PROFIBUS Master station 地址：
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9. 将从站 PD-100S配入到 PROFIBUS网络配置当中，并将输入输出数据块，映射到 S7-300或者其它控制器

的内存当中。

操作中分为两步，第一步将 PD-100S，拖到左上方网络配置中，拖到 PROFIBUS-DP总线之上，鼠标会变

化形状，表示可以放入了。第二步是将数据块拖动到左下方数据映射表格中，映射到 PLC内存。

注意：

1、PD-100S在 PROFIBUS DP主站侧可最多配置为 244字节输入输出。

2、PROFIBUS DP从站的地址要与模块的拨码开关设置一致！

10.如上图所示，可右键点击输入输出映射的槽位，设置相关属性，弹出的界面如下图所示：

将数据块拖动到

左下方表格中
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在该页面中可设置输入输出映射区的起始地址。当选择 consistent数据块时，完整性为“Total length”。

11. 编译下载到 PLC。
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九、Step7如何读写网关数据
PD-100S支持的长度完整（Total Length）的数据块如下所示：

2 Words Input Consistent

4 Words Input Consistent

8 Words Input Consistent

16 Words Input Consistent

2 Words Output Consistent

4 Words Out put Consistent

8 Words Out put Consistent

16 Words Out put Consistent

在 Step7编程时须采用打包式发送与接收。打包式发送与接收主要用到 SFC15（打包发送）和 SFC14（打

包接收）。

SFC14

SFC15

PD-100S支持的字、字节完整的数据块如下图所示：
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在 Step7编程时可以使用MOVE指令对数据进行读写。
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十、安装

10.1 机械尺寸

尺寸： 40mm（宽）×125mm（高）×110mm（长）

10.2 安装方法

35mm DIN导轨安装
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十一、运行维护及注意事项

 模块需防止重压，以防面板损坏。

 模块需防止撞击，有可能会损坏内部器件。

 供电电压控制在说明书的要求范围内，以防模块烧坏。

 模块需防止进水，进水后将影响正常工作。

 上电前请请检查接线，有无错接或者短路。

上海泗博自动化技术有限公司
SiboTech Automation Co., Ltd.
技术支持热线:021-5102 8348
E-mail: support@sibotech.net
网址：www.sibotech.net

http://www.sibotech.net
http://www.sibotech.net
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